ExamView 8.1
Welcome Screen
Every time you start the ExamView Test Generator software, the program displays the Welcome Screen
unless you have changed the preference settings. Use the QuickTest Wizard or the Test Builder options to
create a test. If you want to edit or add questions in a question bank (or database), use the Question Bank
Editor.

The Welcome Screen includes the following options:
Create a new test using a wizard. The wizard provides step‐by‐step instructions that will
lead you through the process of building a test.
Create a new test from scratch. The program will start the Test Builder, prompt you for a
test title, and display a new (empty) test. Then you may begin selecting questions to
include on your new test.
If you want to open an existing test to print or edit/add questions to a test that you
previously saved, choose this option. The program takes you to the Test Builder and
displays a dialog box from which to locate and choose a test file. After you open a test, you
can print it, add/edit questions, or change the layout using the options in the Test Builder
module.
Select this option if you want to create a new question bank from scratch. You can add up
to 250 questions of varying types, such as multiple choice, true/false, essay, completion,
etc.
Choose this option to edit or add questions in an existing question bank. You can edit
questions in the publisher‐supplied banks or in any question bank you may have created.
Open a question bank file and then choose the Question Bank Editor options to edit
questions, add new questions, or delete questions from the bank.

Switch Between the Test Builder and the Question Bank Editor
The Test Builder and the Question Bank Editor are separate parts (or modules) of the ExamView Test
Generator program. The active module name will be displayed in the title bar of the main ExamView window
following the active file name. You can easily switch from one part to another by following the steps listed
below.
1. Save the current test or question bank.
2. On the File menu, click Switch to...
3. Choose to open or create a new test/question bank.
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Test Builder Tool bar
The Test Builder tool bar provides ready access to the most commonly used tools. Because all the tool bar tool
functions can also be accessed using menus, you may select to turn off the tool bar completely to allow the
maximum screen space for viewing the test. Not all tool bar tools are available for the Macintosh, so Mac
users will need to use alternate selection methods for these tools (see table footnotes). Windows users can
further customize their tool bar to select which tools are displayed and the size of the tool icons
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Build a Test with the QuickTest Wizard
The QuickTest Wizard provides the quickest and easiest way to generate an ExamView test for new users by
providing step‐by‐step instructions. Let the wizard guide you through the four steps to test creation.
1. Click the QuickTest Wizard tool bar icon
or choose QuickTest Wizard from the File menu.
If you just started the program or switched to the Test Builder, you can choose Create a new test using
a wizard from the Welcome Screen.
2. Enter the test title and click the Next button.
3. Double‐click a folder (if necessary) to display a list of question banks.
4. Choose the question banks from which you want to select questions..
Click the Folder button to identify the location of the files if no question banks appear in the list. If you
assigned a password to the question bank, you will be prompted to enter the password before you can
continue.
5. Identify how many questions of each type you want on the test.
6. If prompted, enter the number of matching groups you want the wizard to use when it selects the
matching questions you requested.
7. Review the test summary and then click Finish to complete the process.
When you click the Finish button, ExamView selects the questions based on your responses and
displays them in the test document window.
8. After the program displays the test, you can edit/create questions, select additional questions,
customize the appearance of the test, save your work, or print the test.

Creating a New Test and Selecting Questions
The Test Builder and the Question Bank Editor are separate parts (or modules) of the ExamView Test
Generator program. Be sure that you are working in the Test Builder module.
1. Click New Test tool bar button
or choose New Test from the File menu.
If you just started the program or switched to the Test Builder, you can choose Create a new test from
scratch from the Welcome Screen.
2. Enter the test title (e.g., Chapter 1, Midterm, Section 1 Quiz, etc.).
3. Add up to 250 questions per test using any of the six question selection options.
4. (Optional) Edit any of the questions you added to the test, or create a new question from scratch.
5. (Optional) Customize the appearance of the test.
6. Save the test.

Edit/Create Questions on a Test
1. Identify (highlight) the question in the test window.
2. Click the Edit button located at the bottom of the test window, or double‐click the question to display
an editing window.
3. Edit the question, change the answer, update the narrative, and/or modify the question information
(objectives, difficulty code, reference, topic, or notes).See the Entering/Editing Questions help topic for
more detailed instructions.
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4. Click the Record button to accept all of the changes you made to the question. The program applies
the changes only to the copy on the test. The original question in the question bank is not updated.
Tip: Use the Question Bank Editor to permanently change a question or to add a new question for use on
other tests.

Delete a Question from a test:
1. Highlight the question to delete.
2. Click the Delete button located at the bottom of the test window.
3. Confirm that you want to remove the question from the test.
Important: Removing a question you selected from a question bank does not affect the original question.
However, the program permanently deletes any new question you created and/or a question you edited.

Insert a Picture from a File:
1. Position the cursor at the location where you want to insert the picture.
2. Choose Picture from the Insert menu.
3. The default picture type is bitmap (.bmp). Click the List files of type box and choose the type of picture
files you want to insert. The program supports most common graphic formats including: bitmap
(.bmp), jpeg (.jpg), TIFF (.tif), and Macintosh PICT (.pct).
4. Change the folder to locate the picture file you want to open. If the file is located on a different drive
or on a network, identify the location of the file.
5. Double‐click the file you want to open.
The program inserts the picture at the current cursor location.
6. After you insert a picture, you can resize it or set the baseline.
You cannot move an image in a question by clicking and dragging it. If you need to move an image, click on it,
cut the picture, and paste it at the new location.
Tip: Another way to insert a picture is to copy an image from another application (such as Paint) and paste
it into a question or answer. If you have an image file that is not supported by ExamView Test Generator,
try opening it in another program. Then, copy and paste it into a question.

Spell Check an Entire Test:
1. Click the Spell Check toolbar button
or choose Spell Check from the Edit menu while a visual test
appears on the screen.
Before you spell check your work, you can set the options to skip the following words: all‐cap words,
words with numbers, and mixed‐case words. Click Options to change these settings.
2. Click Start to check the spelling on a test.
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3. If the spell checker finds a word that is not in its dictionary, the program highlights the word and gives
you several choices. Choose one of the following:
 Skip Once: Skip the highlighted word one time without changing the word.
 Skip Always: Ignore the word every time it appears.
 Add: Add the word to the custom dictionary.
 Replace All: Replace all occurrences of the word throughout the entire question bank.
 Replace: Replace only the current instance of the highlighted word.
4. Click Done when you finish using the spell checker.

Spell Check a Question:
1. Click the Spell Check toolbar button
while entering/editing a question.
Important: If you are entering a question with an open‐ended response (e.g., short answer), you must
separately check the spelling in the question and then in the answer. Position the cursor in the section
you want to spell check.
2. Click Start to check the spelling.
3. When the spell checker identifies a misspelled word, choose to skip it once, skip it every time, add the
word to the custom dictionary, replace all occurrences of the word, or replace only the current
instance.
4. Click Done when you finish using the spell checker.
Notes:


You can click the Custom button to add or remove words in the custom dictionary.

Mix Question Types on a Test
By default, ExamView groups test questions by their question type (e.g. multiple choice, true/false, etc.). You
can choose not to group questions by type by doing the following.
1. Click the Mix Question Types button
‐ or –
1.
2.
3.
4.

on the tool bar.

Select Preferences from the Edit menu.
Within the preferences dialog click the Layout icon and then click the Question Types tab.
Select the Allow question types to be mixed radio button.
Click OK. (Click Save As Default if you want all future tests to allow for mixed question types.)
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Reorder the Questions on a Test Grouped by Question Type
1. Click the Reorder Questions tool bar button
or choose Reorder from the Question menu.
2. Click on an item (individual question, question type group, or narrative group) and hold down the
mouse button while you drag the item to the new location in the list. Alternatively, press either CTRL+
/CTRL+ (Windows) or + / + (Macintosh) to move the highlighted question.
Rules:



You can move a question only within the same question type.
To move an entire question type group (e.g., multiple choice), click on the question type title
and drag it to the desired location.
 You can move a group only to certain places in the list. The insertion bar appears as a thick line
to indicate where you may move the question group.
 Questions attached to a narrative can be moved only within the same narrative group.
 A question not a part of a narrative group cannot be moved into that group. Likewise, you
cannot move a question linked to a narrative outside of the group.
 Matching questions can be moved only within the same matching group.
3. Repeat Step 2 for each item you want to move.
4. Click OK to update the current test.

Sorting Questions
In addition to reordering questions in a test/question bank, you can sort the questions based on various
criteria provided that Allow for mixed question types is enabled. This feature is useful for quickly adding
another layer of organization to your test/question bank. For example, questions can be sorted to present
the questions in order of increasing difficulty level or to group questions by state standard. Note that in order
to utilize this sorting feature, questions must contain descriptive meta‐data information.

To sort the questions in a test/question bank:
1. From the Reorder Question dialog, click the Sort button.




If a Sort button is not visible, click the Cancel button and enable the Allow for mixed question
types preference. See the topics about mixing question types (for tests and for question banks)
for details.
Sorting is only allowed if at least some of the questions contain information that can serve as
sorting criteria.

2. From the pull‐down menu on the Sort Questions dialog, select the criteria to use as the basis for the
sorting action.



The Sort by list can sort by any of the question information fields, such as Difficulty, Reference,
Topic, State Standard, and Keywords.
The Sort by list will only contain entries for question information fields that contain at least
one entry for the questions being sorted.
January 2013

Page |6



Sorting treats the entire entry of a question information field as a single entity, even if it
contains multiple entries separated by an item delimiter character. For example, if a question
contains two keywords stored as ”r;energy | heat”, the category would appear exactly as
shown rather than as separate entries for ”r;energy” and ”r;heat.” Further, if another question
contains just the keyword ”r;energy”, it would not be recognized as being a subset of the
previous question with multiple entries.

3. A preview of all the entries for the sort criteria will appear in the list box below the pull‐down list.
Drag an entry up or down to reorder the list to the desired sort sequence.



Entries are always initially shown in alphabetical order, not by the order that they appear in
the current question order.
Changing the sort criteria or closing the Sort Questions dialog resets the order of the entries to
the initial alphabetical sequence.

4. Click OK to apply the sort order to the questions. The question order displayed in the Reorder
Questions dialog will now reflect the sorting order.

To scramble the questions on a test:
1. Click the Scramble tool bar button
or choose Scramble from the Question menu.
The Scramble option is different from the Reorder command in that the Reorder command lets you
move questions one at a time or in a group. And, you can move them exactly where you want the
questions to appear. With the Scramble option, the program randomly rearranges the questions. If
you prefer, you can automatically generate different versions when you print a test.
2. Choose one or more of the scramble options: sections, questions, and choices.
3. You may assign a new test ID (A‐Z) each time you scramble the questions.
4. Click OK to scramble the current test.
Note: This option permanently changes the question order on a test.

Print a test
1. Click the Print tool bar button
or choose Print Test from the File menu.
2. Specify the number of test variations to print (1‐26).
3. Choose to scramble sections, questions and/or multiple choice answer choices. If you choose to
scramble sections or questions, you can also choose to print a version map—a correlation chart to
show you how the test was scrambled.
4. If your test contains dynamic questions, choose whether you want to calculate new algorithm values
for each variation of the test.
5. Indicate whether you want to print an answer strip.
6. Indicate whether you want to print a version map.
7. Click OK to confirm your responses.
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8. In the Print Test dialog box, choose to print the entire test or selected pages and then click OK to print
the test.
Note: You cannot print selected pages if you chose to print an answer strip or multiple versions of a test.

Saving a test:
1. Click the Save tool bar button
or choose Save from the File menu.
If you already saved the file, the program will automatically save the current test with the same file
name to the same location.
2. Enter a name for the test (with a .tst extension) if this is the first time that you have chosen to save
the test.
3. Identify the folder where you want to save the test. If you want to save the file on a different drive or
on a network, choose the location.
4. Click the OK button to save the test.

Exporting questions from ExamView:
1. Click the File menu and point to the Export command.
2. Specify the file type:
HTML (.htm) – for importing into SMART VE
Blackboard (.zip) – for importing into D2L
3. Enter a new file name.
4. (Optional) Select a folder to identify the location where you want to save the file. If you want to save
the file on a different drive or on a network, choose that location.
5. Click the OK button to export the question bank.
6. Some export format require additional settings to be specified and an options dialog will appear.
Complete the required fields to continue the export process.
7. Watch this screencast http://www.youtube.com/watch?v=FnQTcXRnY_Y on how to export from
ExamView and import into D2L
8. Screencast for SMART VE coming soon.
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D2L Supported Question Types
The export feature maps ExamView question types to the closest corresponding Desire2Learn question
format. A summary of the question type mapping (from the Blackboard 7.1‐9.0 export) is shown in the table
below.
ExamView Question Type
True/False
Modified True/False
Multiple Choice
Bimodal
Multiple Response
Yes/No
Numeric Response
Matching
Completion
Short Answer
Problem
Essay
Case
Other

Equivalent Desire2Learn Question
Type
True/False
True/False
Multiple Choice
Multiple Choice
Skipped
Multiple Choice
Short Answer
Matching
Short Answer
Long Answer
Long Answer
Long Answer
Long Answer
Long Answer

Multiple Response
question do not
import into D2L and
are skipped.
Point values do not
import into D2L. All
questions import with
a 1 pt. value.
All questions import
with no enumeration
(e.g. A, B, C or 1, 2, 3)
for answer choices.
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